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Software Purpose

The Software is designed to load data to the POSC Epicentre database.

The main operations performed by the software are:
● loading input data to the database;
● unloading the loaded data;
● updating the loaded data;
● selective removal of the loaded data.

A user of CLUETool doesn’t have to be an IT specialist in databases and data management. With
the help of CLUETool Editor a specialist in geological and geophysical sciences can create
datasets for data loading including fields of different types, QC criteria for input data and many
other things. The Tool is based upon simple ER-diagrams and a fully documented POSC
Epicentre dictionary with enough diagrams and illustrations of entities and their attributes.

CLUETool Loader includes a set of built-in templates and forms for interactive data input and
preliminary batch processing. It is a huge amount of acquired experience in exploration and
development data QC (analysis of seismic, wells, recovery, reservoir etc.). Forms of CLUETool
are adapted to international standards for a wide variety of business-objects and their properties.

CLUETool has been created on the basis of modern technologies and can be integrated with
various data loading applications.

Main characteristics:

● includes a set of modules necessary for data modeling, defining QC and data loading;
● includes a big amount of built-in templates/forms and QC restrictions for objects and

streams of data from exploration and production (E&P);
● supports Oracle (11g R2+) and Postgresql (9.0+);
● requires Linux OS (RHEL5/RHEL6/RHEL7) or Windows (7+) to work.

Key benefits:

● allows to manage exploration and production data and national data storage;
● does not require any additional software to prepare data but can be integrated with any of

it;
● intuitive user interface based on years of experience in exploration and production in the

oil and gas sector.
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Launching CLUETool Loader

When launching the application, the first thing the user sees is an authorization interface. It is
necessary to enter an appropriate username and password.

Launching CLUETool Loader

If you are a registered user and have entered the username and password correctly, you will see
the CLUETool Loader working window.

CLUETool Loader main window
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Application Interface

INTERFACE OVERVIEW

The interface of the application consists of dynamically generated panels. In case if any of the
panels is not needed, it can be minimized or closed for the current session. It can be turned on
again from the Panel menu item.

For the convenience of using the application, each control element is provided with a hint. In
order to see a hint you need to hover and hold the mouse cursor over the desired button.

General view of the panels
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“Catalog” menu is responsible for displaying all available download templates. You can
expand/collapse a group node by double-clicking the mouse or by clicking on the icon.

“Catalog” Panel

The “Dataset Properties” panel displays the properties of the dataset selected in the catalog.

“Dataset Properties” panel
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The “Form” panel contains a form for entering values into data record fields.

“Form” panel

In the "Input Data" panel there is a table containing the rows that will be loaded to the database.

“Input Data” panel
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The “Unloading” panel contains information that is already loaded into the database.

“Unloading” panel

"Debug Panel" is an auxiliary tool that facilitates the development and debugging of system
software modules.

“Debug Panel”
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In the "System Log Panel" tab you can see system messages. The tool is designed to help the
user and the developer and it allows you to visually track the process of taken actions.

“System Log Panel”

● Clear System Log

● Save System Log to File

In the "Batch Loading" panel, you can import and load several datasets simultaneously.

“Batch Loading” panel
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APPLICATION MENU

FILE

“File” >”Open Scheme”

All work in the application occurs through predefined templates, which are contained in special
files - “schemes”. Before starting work, you should choose a scheme containing the template

necessary for work by using the “Open Scheme” button, or by choosing the menu item
“File” >”Open Scheme”.

“Open Scheme”

“File” > “Recent Files”

For quick access to recently opened scheme files, you can address to the user history which
contains a list of all the schemes that the user opened. From the history panel you can quickly
open a newly created dataset.

TOOLS

“Tools” > “Change Database Connection”

Allows you to create a new database connection or select another connection. In the dialog box
you can see the database with which the connection is currently established. On pushing this

button: - Change Database Connection – there will appear a list of all existing connections.
You can edit an existing or create a new connection. For this purpose there are several commands
with which you can perform the above mentioned actions:
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● Add Connection;

● Edit Connection;

● Remove Connection.

On adding a new connection a window will appear in which you should fill in the fields:
● Connection Name – a unique name of the connection which is used to access the

connection properties;
● Host Name – the name of the machine/computer on which the application is running;
● Database Name – the name of the database with which the application will work;
● Database Type – a variable that defines the DBMS used, on which the application should

run.

Thus, the user can reconnect or configure a connection to the database on their own.

Finally, enter the username and password for the correct connection and click OK. The same
function has been moved to the application panel for the user’s convenience:

Change Database Connection.
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“Tools” > “Options”

In the “Appearance” dialog window you can customize the appearance of the application to
your needs. It is permissible to change its structure and appearance, for example, to configure the
placement of tabs, display of floating windows, change the style, etc. the changes made will take
force after you restart the application.

Options - Appearance

The function “Undo/Redo” allows you to cancel the last operation performed on the data, or
repeat it again.

The “Undo/Redo” dialog contains settings for disabling the undo and redo functions, as well as
disabling automatic saving of undo/redo data to a file.

Options – Undo/Redo
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The “Loading Settings” dialog enables you to set the size of a loading block (the number of
lines that will be processed in one transaction). This option is used in the case when equipment
configurations allow loading data not in one transaction, but in several parallel ones.

“Loading Settings”

WINDOW

All windows in the application can be accessed through the “Window” menu.

“Window” menu

Reset Windows – restore the interface to the original version;
Configure Window:

● Maximize – maximize a window;
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● Float – open a window in a separate tab;
● Float Group – open a group of windows in a separate tab;
● Minimize – minimize a window;
● Minimize Group – minimize a group of windows;
● Dock – dock a window to the panel;
● Dock Group – dock a group of windows to the panel;
● Clone Document;
● New Document Tab Group;
● Collapse Document Tab Group;

HELP

If you select this option, an information window will open in which technical information about
the application is indicated.
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DATA PANELS

«FORM» PANEL

Form panel is used to enter field values. Here you can prepare the input data row for further
loading. The panel content is associated with the selected row in the "Input Data" table. Thus,
the panel helps you to quickly create a new row and at the same time provides a convenient
access to necessary rows while editing existing data in the table.

General view of the “Form” panel

At the top of the panel there is a toolbar with some buttons. The description of the buttons is
given below.

● New Record – Creates a new record and adds it to the “Input Data” table. The form
is filled with default values;

● Duplicate Record - Creates a new record and adds it to the “Input Data” table. The
form is filled with values from a source record;

● Remove Record – Removes a record which is being currently edited in the panel;

● First Record - Shifts focus to the first record of the “Input Data” table;

● Previous Record - Shifts focus to the previous record of the “Input Data” table;
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● Next Record - Shifts focus to the next record of the “Input Data” table;

● Last Record - Shifts focus to the last record of the “Input Data” table;

● Erase Data – Automatically erases (removes) all input data being currently edited in
the panel.
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“INPUT DATA” PANEL

The “Input Data” panel contains a tabular section with data prepared for loading into the
database and at the same time serves to visualize the data.

General view of the “Input Data” panel

In the lower part of the panel there is a toolbar containing the commands that allow you to
perform the following actions: open a dataset, conduct its QC, create new elements, filter or
remove rows, create a data file, load data etc.
The commands in the toolbar are described below:

● Import Data from File – Import data from a file on the disc. The formats supported
are CSV, IN, DBF, DB, XLS, XLSX;

● Batch Load – Import data from a specific directory according to predefined rules.
The function will be active only if the selected dataset supports batch loading of material;
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● Load Undo File – Saving files necessary to undo loader actions. After every
operation the program automatically saves an undo file which can be opened later in
order to reverse changes made by the loader.

Files have the extension .in and when you open such a file, the dialog window shows only those
files that are suitable for the current dataset. Files created for other sets are not visible.

“Load Undo File”

Import Properties -
To convert numerical, textual, graphic, sound information to digital, it is necessary to use
encoding. Data encoding is the process of forming a certain presentation of information.

You can use the standard default settings, and at the same time, the user can independently
change data encoding settings and date format. We recommend that you set the date format,
encoding, and tick the box “Do not show encoding selection window”, which will allow you not
to waste time on determining such things in the future.

On closing the window, the settings made by the user are saved and become the default settings
for the current user.

18



CLUETool Loader User Guide

“Import Properties”

Check Data Quality - Checking the quality of the data in the table. Checked data is marked
with special icons in the “Status” column.

Load Data. Load/update data from the “Input Data” table to the database. The operation
(load/remove) is determined based on the status of the row.

Recovery
Throughout an entire work session in the application, the user has an opportunity to return the
Database to the state that was before operations of loading, updating and deleting performed with
data.

After successful loading, the operations performed by the loader can be canceled: this is

indicated by the icon that appears in the “Status” column. For that purpose, there are two
buttons on the toolbar:

● Undo - This option will apply to all data in the table.

● Undo for Selected Rows - This option will apply only to selected rows in the
table. The data in the database will return to their previous state.

You need to select a row and click the “Undo for Selected Rows” button on the toolbar below the
table.

A row after “Undo”
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Please note that the “Undo” icon has not disappeared. This means that you can load the row
again. Please also note that the status icon has changed from “Loaded Successfully” to
“Removed Successfully”.

Transform Data - Allows you to view the list of available transformations for datasets, as
well as apply them.

Find Duplicates - Starts searching for duplicates in a table. Found duplicates are deleted.
Before this, the program offers to save them to a file.

Load Selected Data - Loads into the database only those rows that are selected by the
user.

Save Selected Data - Rows selected by the user are saved to a file. Supported formats are
CSV, IN, DBF, DB. Next, select encoding for the file, which will determine the working
encoding for input files, and click "OK".

“Save Selected” Selecting encoding for the file

Add Row – An empty row will be added to the table.

Duplicate Row – A copy of a selected row will be added to the table.

Remove Selected Rows – Removes selected rows from the table.
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Mark as “Delete” – Marks selected rows with a special marker. These rows will be
deleted the next time the loader processes the input.

Mark as “New Row” - Marks selected rows with a special marker of a new row with a
status «Ready for Loading». These rows will be loaded the next time the loader processes the
input.

You can also use the pop-up tools menu by right-clicking on the table.

Tools menu
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Quality control icons

Row QC icons are displayed in the Status column after applying the command – Check
Data Quality. Each row is assigned a status that allows you to determine whether the contents of
the row correspond to the format of the fields. Only valid rows are allowed for loading into the
database.

Row status is determined by the second icon - the quality control mark.

An example of QC icons

Detailed information about the cause of the error in the lines that did not pass a quality control
check can be obtained in the error window by double-clicking the status icon.
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Error window

To fix the error, select this line and go to the "Form" panel, and there fix the incorrect values so
that they correspond to the format of the field

The meaning of the QC icons is given below:

● Valid Row - The row is checked and meets the quality criteria;

● Invalid Row - The row is checked, but does not meet the quality criteria. Change
invalid data and retry loading;

● Row Not Checked - The row has not been checked.
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Row status in the "Input Data" table

Each row in the "Input Data" table has a status. The first status icon in “Status” determines the
status of a row in the table. It appears and changes after some manipulations with a row have
been performed.

General view of status icons

Possible statuses when loading data:

● Import Error - There occurred an error while importing a row. The row is skipped
at loading. Rows cannot be loaded until the cause of the calculation failure has been
resolved;

● Ready for Loading - The row will be loaded when loading starts;

● Row Loading Failed - An attempt to load a row failed, resolve the cause of the
failure;

● Row Loaded - The row has been loaded successfully;

● Row Needs Updating - The row was changed after loading successfully and needs
to be updated;

● Row Marked “Delete” - When the loader starts, it will remove the selected rows;

● Row Removal Successful- The row has been removed successfully from the
database;
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● Row Removal Failed - A failure has occurred; the row has not been deleted from
the database;

● Data Updated - Means that there have been changes in some values when updating
data;

● Duplicate Rows - When loading, the status means that such a line is already stored
in the database. When updating rows, it means that no changes in the values have
occurred.

Detailed information about the errors of rows with the statuses “Import Error”, “Row Loading
Failed”, “Update Failed” and “Row Removal Failed” can be obtained in the error window that
appears when you double-click the status icon.
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Fields with invalid format

Please note that fields can contain information of various types:

● text;
● floating point number;
● integer value;
● date etc.

If the entered value does not match the format of the field, then in the “Input data” table such
cells will be highlighted in red. This means that a fill check has been performed for them. If you
leave some column of the tabular section blank, which should not remain empty at loading, and
try to load the row, you will also receive an error message.

Invalid format field example

To fix the error, select this line and go to the "Form" window and fix the incorrect values so that
they correspond to the format of the field.

All errors that occurred during importing, verification and loading of data can be exported from
the “Input Data” to a DOCX, ODT or PDF file. Access to the report wizard is done through the
main menu: Tools > Generate Report.
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Importing input data
In order to load information to the database, you first need to fill out the table in the "Input
Data" panel. There are several ways to do this:

1. Filling in the table using the "Form" panel;
2. If data has been prepared in an external program, rows can be imported from a file with

saved results, supported formats are: CSV, IN, XLS, XLSX, DBF and DB;
3. Some datasets support the import of prepared material from a specified directory (batch

download).
4.

Depending on the dataset, the imported material can be transformed, for example, empty fields
are filled with default values, the values of one field are calculated depending on the conditions
imposed on other fields, etc. The process of material transformation is called pre-processing of
the input data.

When importing data, regardless of the data source, several steps take place:
1. Format selection: here you can select the desired settings profile or create your own

profile;
2. In the “General” window, you can configure the delimiter character between fractional

values and set the date format. You can also select "Detailed log" for further detailed
explanation of an error, if it occurs;

3. Mapping input data columns to the dataset fields. The fields that are calculated in the
"Pre-Processing" will remain empty if you check the box next to the field. If the number
of fields in the form matches the number of fields in the input file, you can use the Auto
button (automatic mapping), or select the field values manually.

In the rule set, fields are calculated, values from which will be substituted when an input file is
opened, based on the values of any other fields. Possible calculations in the "Pre-processing" are
selected by a tick.

All fields that were omitted during "mapping" and are not calculated in the "Pre-Processing" will
remain empty in the final table in the "Input Data" panel. At subsequent openings of files of the
same name for one form, “mappings” are saved. “Reset” the current settings is used to delete all
the settings of the “mapping” dialog stored in the memory for the form with which the user is
currently working.
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“Pre-processing of the Input Data” window

Before adding a row of input data to the “Input Data” panel, the loader takes turns taking
auto-substitution objects and checks the row for compliance with the conditions of the current
object. If the line passes, then the calculations specified in the auto-substitution object occur.
This happens with every object. Next, the values of the fields in the buffer are copied to the
current line, and the line is displayed in the "Input Data".

When data appears in the “Input Data” table, those rows for which a failure occurred during the
calculations are marked with special icons, the rest are marked with the “Ready for Loading”
icon.

The reason for the failure can be found by double-clicking on the row of interest. The window
that appears contains descriptions of all errors associated with this row, including preprocessing
errors and quality control errors.

Lines marked with the “Import Error” icon cannot be loaded until the cause of the calculation
failure has been resolved. When you click the "Load Data" button, these lines will be skipped.
After the cause of the calculation failure has been eliminated, you can restart it by clicking the
"Transform Data" button. If the repeated calculations are successful, then the “Status” of the
row will change to “Ready for Loading” and it will be available for loading. You can also
postpone the correction of import errors, and the data that has not passed pre-processing can be
saved to a file with a supported format.
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Undo loader actions

Throughout an entire work session, the user has an opportunity to return the database to the state
that was before the operations of loading, updating or deleting the data.

Let us consider the example of loading a new row.

A prepared row ready for loading

After entering data, we use the “Load Data” button, wait until the data is transferred to the
database and a dialog box with a message about successful loading will be displayed. The Figure
shows that, after the successful loading, the operations performed by the loader can be canceled;
it is shown by an icon that appears in the "Status" column. To perform a download cancellation,

the “Input Data” toolbar has two buttons and .
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A loaded row

To make sure that the row really disappears from the database after the loader action is canceled,
we first extract the row in the "Unloading" panel.

After that, return to the “Input Data” panel and discard the changes made by the loader. To do
this, perform the following steps:

● select a row or several rows that should be unloaded;
● apply the "Undo for Selected Rows" button on the toolbar below the table.
●

The result is shown in the figure. The undo icon has been saved. This means that the row can be

loaded again. The status icon has changed from “Loaded Successfully” to “Removed
Successfully”.

Undo row loading
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After each operation, the program automatically saves the undo file, which can be opened later in
order to reverse the changes made by the loader.

Load Undo File

Files have an extension .in, and when opening such a file the dialog window shows only those
files that are suitable for the current data set. Files created for other datasets are not visible.

“UNLOADING” PANEL

The panel which contains a table with the material unloaded from the database.

General view of the “Unloading” panel

At the bottom there is a toolbar with buttons, the description of which is given below:
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● Unload Data - After clicking this icon, a “Filter” panel appears, on which you can
enter conditions for selecting data;

● Delete Selected Records - The data selected in the table is removed from the
database. Before removing, it is assumed that the data has been unloaded from the
database;

● Update Selected Records - The data selected in the “Unloading” table is copied to
the “Input Data” table. Each row gets the status of "Loaded" and can be changed in the
"Form" panel;

● Delete Selected Records and Files - Permanently deleting selected rows from the
database and after that deleting the files themselves;

● Import Data for Removing - Import meta-data to further delete physical data.
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Unloading information using data filtering
Unloading data is required, first of all, for performing operations of updating and deleting the
loaded material. Since the databank involves a huge amount of loaded material, it does not make
sense to unload it entirely. Therefore, only the data with which it is necessary to work directly is
unloaded. In order to select the required portion of material, a “Filter” component is used. This
function allows you to configure the conditions that the unloaded data must satisfy. For example,
rows from a specific day or period of a day, or related to a specific well, or downloaded by a
specific user in the last week. The filter allows you to unload the necessary data. Conditions can
be combined with each other by AND/OR links.

Possible conditions: equal, not equal, more, less, more or equal, less or equal, like, contains.
Each link has a form “FIELD” condition “FIELD/VALUE”.

For example:
“Code” contains “40”
“Creation Date” more or equal “2014-04-17”
“Row Creator” equal “POSC”

Filtering data by ff1 fields and creation date

The result of filtering data by ff1 fields and creation date.

The result of data filtering
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Service columns
In the “Unloading” table, in addition to the columns with input data, there are two additional
columns: “Creation Date” and “Row Creator”. Both columns can be used as conditions in the
"Filter" panel.

The load date is equal to the system date of the server/computer, the date contains the time
accurate to the second. This allows you to control the sequence of data loading.

The “Row Creator” field shows who loaded the data.

An example with additional columns
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TABLE ROW COUNTER

The tables “Unloading” and “Input Data” have counters located in the upper right corner of the
panel. The counter shows how many rows are in the table, the number of the first selected row
and the total number of selected rows.

For example,
6/13 means that there are 13 rows in the table and that the first selected row is 6;
31(5)/70 means that there are 70 rows in the table, 5 rows are selected and the first selected row
number is 31.

“Unloading” panel
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TABLE SORTING

For various tasks, you may need the “Sort Table in Descending/Ascending Order” function,
which can be called with one click on the header of any column. For example, in order for the
rows with errors to appear together, the “Input Data” table should be sorted by the “Status”
column by left-clicking on the column header. The table will be sorted and the rows with the
same statuses will appear next to each other.

An example of a table sorted by the “Status” column

36



CLUETool Loader User Guide

SELECTING ROWS IN A TABLE

The ways of selecting rows in the “Input Data” and “Unloading” tables are presented below:
● Ctrl+A – select all rows;
● Click, Shift + click – select a range; the first and last row of the range is indicated;
● Ctrl + click, Ctrl + click – select multiple rows;
● Click-and-drag – select a range; the first and last row of the range is indicated;

Table row selecting is necessary for various operations, such as deleting and saving rows. Before
you select the desired rows, you first need to sort the table so that the desired rows are next to
each other.
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“BATCH LOADING” PANEL

It is a panel with a table into which information on all templates is imported and loaded.
Due to the simultaneous processing of several sets, the time spent on processing and loading
material into the database is reduced.

“Batch Loading” panel

The “Batch Loading” panel contains tables that include material information related to the
corresponding datasets. The panel also has a number of control components

● Choose Import Directory - Import directories for processing material for all data
sets.

● Find Duplicates – Find duplicates in a file.

● Load Data – Load all the imported rows into the database simultaneously.

● Save Invalid Data - Save rows that have not passed the process of material
validation to a text file
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Operation Scenario

LOADING DATA INTO THE DATABASE

LOADING DATA WITH THE HELP OF THE “FORM” PANEL

In order to open a scheme in the loader you need to select "File" on the menu bar, then "Open
Scheme" and specify the path to it in the scheme selection dialog. The "Catalog Window"
displays a tree of datasets. You can open the group node by double-clicking or by clicking on the

button.

Opening a scheme

Fields in the “Form” panel are locked. In order for the fields to become active, use the "New
Record" function.

Creating a new record in the “Form” panel
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Then you need to fill in the fields manually in the "Form" panel.

Input data in the “Form” panel

Records added using the “Form” panel are not pre-processed. The row is displayed in the “Input
Data” table and is marked with a “Ready for Loading” icon. After the record has passed the
quality control check, it can be loaded into the database. To do this, use the "Load Data"
function. Upon completion of data loading, a message is displayed with the result of loading.

A row ready for loading

In order to unload this row, use a filter in the “Unloading” panel, set according to a certain
criterion, in this case, by the “code (ff1)” field.
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Data filtering by creation date

The result of loading this record is shown in the figure.

The result of loading the data
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LOADING INPUT MATERIAL FROM A MEMO FIELD FILE

A memo field is a field in .db and .dbf file format that allows you to enter multi-line text. Field
sizes are not limited. The load creates a link to a text file that can be viewed in Petrovision.
In order to fill in the table in the “Input Data” panel, it is necessary to import data from a file
with saved results.

Importing data from an input file

On importing material, the following procedures are performed:
1. The fields calculated in the "Preprocessing" dialog (in this example, one field -

PV_UWI) remain empty, check the boxes next to the fields, and click the Auto button, or
select the field values manually in the "Mapping" section. Calculated fields are those
fields whose values will be substituted when opening the input file, based on the values
of any other fields

2. The use of transformations (pre-processing). Select possible pre-processing calculations
(in this example: “calculate PV_UWI”).
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Pre-processing window

In the “System Log Window” you can track the process of the script, and after processing all the
data, the material is correctly imported into the “Input Data” table, each entry is marked with a
“Ready for Loading” icon. In the column where the memo field should be (in this case, the ff50
field), a link to the text file is created.
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Opening a data file

After opening a file, the data should be sorted by the Status column by left-clicking on the
column header, for some rows may have been imported incorrectly.

Incorrectly imported rows
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After sorting, the incorrectly imported rows appear at the top of the table, and all these entries
have the status “Import Error”. It is necessary to find out the cause of the error and eliminate it.
Double-clicking on the line of interest will display a window with a detailed description of the
error. After fixing the error, repeat the import.

A window with a detailed description of the error

Data should also be sorted by the Status column after a quality control check, since not all the
data can satisfy the quality of the check. Lines that fail the quality control check appear at the top
of the table, and all these records have the status “Invalid Row”. It is necessary to find out the
cause of the error and eliminate it. Double-clicking on the line of interest will display a window
with a detailed description of the error.
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An example of data that has failed a quality control check

Upon completion of data loading, a message appears with the result on the number of
successfully loaded rows.

The result of loading data with memo fields is shown in the figure.

The result of loading data with memo fields
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To view the result of this example in Petrovision, you need to find the field in the spatial tree and
the well for which the data is loaded. In this case: well - 255848006G00518G, field - Tazovsky.
Select an appropriate presentation table. The table with the loaded data is displayed. A link to a
text file is created in the memo field “FILE_NAME”, which can be opened by double-clicking
on the left mouse button.

Viewing the result of loading data with memo fields in PetroVision
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BATCH LOADING FOR ONE TEMPLATE/SCHEME

To process files in an entire directory, you need to specify the directory with files in the file
selection dialog instead of just a file. To select necessary files from a directory, an external
program or script is used, the task of which is to independently read all the necessary data in any
way. This external program is called a batch loader. With this type of loading, the directory is
scanned, and then tabular data is extracted from the file and imported into the “Input data”.

Importing data from a specified directory

In the "Import Format" window, set the fields to be automatically filled out by clicking the Auto
button, or manually select the field values.

Select the checkbox for possible calculated fields called “Preprocessing” (in this example,
“calculate PV_UWI”). These are fields whose values are calculated based on external data.
External data can include values of other fields in the set, already loaded data in the database,
attributes of the source material (such as file size, file type or hash sum).
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Preprocessing window

In the “System Log Panel”, you can track the process of a script, and after processing all the data
the material will be correctly imported into the “Input Data” table, each entry will be marked
with the “Ready for Loading” icon. After the quality control, the data can be loaded to the
database. To do this, use the "Load Data" function. Upon completion of the data loading, a
message appears with the result of loading the input material.

Opening a data folder
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The result of batch loading is shown in the figure below. The input number of records
corresponds to the number uploaded in the “Unloading” panel.

The result of batch loading
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LOADING DATA IN MULTI-PROFILE DATASETS

In order to load data in multi-profile sets, you need to fill out the table in the "Input Data" panel.
Select a file with data in the file selection dialog. Perform a data quality control check. If the data
meets the quality control requirements, then each record is marked with the status “Ready for
Loading”, and the “Load Data” function can be used. For example, in the figure below, it is
planned to download 2D seismic data.

Preparing 2D seismic input material

When the loading is finished, a window is displayed with a message about successfully loaded
and not loaded data. If the loading fails, you need to find out the cause of the error and fix it.
Double-clicking on the line of interest will display a window with a detailed description of the
error. After fixing the error, repeat the loading.

In multi-profile unloading, the “Choose Profiles” button is located at the top of the “Filter”
panel, which serves to unload material loaded on a specific profile. Next to the button there are
all profiles involved in unloading.

Setting the unloading panel
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By default, all profiles for unloading are selected.

Profile selection window

The unloaded material for all profiles in the “Unloading” panel is shown in the figure

Unloaded material for all profiles
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If you need to unload material related to a specific profile, then in the “Select Profiles” dialog
box you need to uncheck the profiles that should not be involved in the unloading. In this
example, we unload data for the “2D Field Acceptance Certificate” profile.

Profile selection window

The unloaded material for the selected “2D Field Acceptance Certificate” profile in the
“Unloading” panel is shown in the figure.

Unloaded material for “2D Field Acceptance Certificate”
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Inconsistent profiles
Profiles, for which unloading the same number of rows that was loaded is guaranteed, are called
consistent. If unloading of the same number of rows cannot be guaranteed, then the profile is
inconsistent. Unloading from inconsistent profiles gives more rows than there were loaded, and it
is disabled by default. In the loader interface, you can see that the names of such profiles are
different from the rest. In the properties of a dataset, such profiles are marked with the word
"inconsistent".

“Dataset Properties” window

In the filter conditions dialog, profiles are also marked.

Filter conditions window

When trying to unload data for these profiles, the user will see a warning message:
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A warning message

Data related to inconsistent profiles is not uploaded by default
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LOADING TOPOGRAPHICAL DATA

In order to load information of the “geometry” type from files containing a field in SDO format
to the database, fill out the table in the “Input Data” panel. This is done by importing a file with
saved results, or filling out a table using the "Form" panel.

Consider an example of importing an input file of SDO type. After the data is displayed in the
“Input Data” table, we check the quality control of the data and load it into the database using
the “Load Data” button. An input format is determined by the scheme itself.

Loading information of the “geometry” type

The result of loading information of the “geometry” type is shown in the figure.

Loading result

56



CLUETool Loader User Guide

Input field values for SDO data should be as follows:
SDO:
<coordinate system name>\t[<name of datum transformation in WGS84>]
<x1>\t<y1>
<x2>\t<y2>
....

Valid example of SDO type data:

20013
329440 774275
330418 776465
331921 777372
335518 779789
336933 783102
341952 782684
336984 770224
….
330326 772072
330336 772079

Valid example of datum transformation for SDO format:

20013 1257
329440 774275
330418 776465
331921 777372
335518 779789
336933 783102
341952 782684
336984 770224
….
330326 772072
330336 772079
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BATCH LOADING

In order to process files simultaneously in all templates, you need to specify in the file selection
dialog a common directory with files for a selected direction. The application automatically
processes the directory submitted to input, and as a result all available files will be read and

extracted. To load data, open the selection dialog using the command – Choose Import
Directory and click on the OK button.

Importing files from a directory

During importing/scanning of the directory, the “Data Search” window will start in the form of a
progress window where the user can track the process and get information about the dataset
being processed at the moment.

Data search

After successful completion, in each set where the file was found, a row with information about
the file, its encoding and file settings will be filled in. Under each set, a status bar called Status is
added, where a message about the result of execution will be displayed.

The user has an opportunity to view or change some parameters that the application
automatically determined. On double-clicking on a value of the Settings column, the already
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familiar Preprocessing window will be displayed. Left-clicking on a column value in the
Encoding table displays a selection that provides the information stored in this field.
Such structure makes the work with file data easier.

Filling in the panel

With this type of loading, tabular data is extracted from files that can be opened by clicking on

the icon - Compiled data. You can perform various manipulations with them using the
available commands, which are standardly present in any panel.

59



CLUETool Loader User Guide

Compiled data

Finding Duplicates

The application looks for rows with identical contents in the file. After using the button -
Find Duplicates, a message with the result will be added to the Status.
This may be required when further loading data into the database.
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LOADING DATA
After the loading is completed, the user will be informed by a message in Status about the
number of successfully loaded data and of unloaded, if any.

Save Invalid Data - Saving invalid rows to a file
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UPDATING DATA

In order to update a data row, you need to unload the material from the database. With a large
amount of loaded material, it is advisable to pre-configure the data filter according to a certain
condition to facilitate the search and unloading of data.

Material has been unloaded from the database to the table. The table counter displays the number
of rows. Select one or several rows for updating by any possible selection method and click the
"Update Selected Records" button.

Unloaded material

Now go to the "Input Data" panel. The rows selected for updating are displayed here.
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Data for updating

Then go to the “Form” panel and change the necessary values.

Data editing

Return to the “Input Data” table; the row values are changed and the row has a status “The Row
Needs Updating”. Use the “Load Data” button. A window is displayed with a message about the
result of the loading.

In the event of a failure the row will not be updated, and it is necessary to find out the cause of
the error by double-clicking on the row of interest, return to the “Form” panel and correct the
field containing the error.
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Data waiting for an update to load

After that, apply the “Load Data” option. After the loading has been completed, the status of the
row will indicate whether the operation is effective. If it is effective, i.e. there are some changes
in the database after its execution, a marker of an effective operation appears in the status - a red
dot in the lower right corner of the cancellation status icon.

Effective data updating

If it is not effective, i.e. there are no changes in the database after its execution (no insertion,
update, or deletion has been performed), a marker of an ineffective operation appears in the
status - a blue dot in the lower right corner of the cancellation status icon.
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Ineffective data updating

Effective operations do not have an additional marker such as

These markers can be useful, for example, in cases where duplicates need to be identified after
loading. For example, after loading 10,000 rows, only 9,997 were unloaded. Three lines that fall
into the difference turned out to be duplicates (that is, they were loaded last month). The loader
marked these lines as ineffective.

In a more popular sense, ineffective rows are duplicates (the row has already been loaded), and
reconciliation rows are duplicates in which the values of updated fields are entered.

In the “Unloading” panel you can see the result of updating the data. Record values have
changed.

The result of data updating
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REMOVING DATA

DELETING DATA IN THE “UNLOADING” PANEL

In order to remove loaded data from the database permanently, you need to unload the material.
To facilitate searching and unloading of data, you can use data filtering by a specific criterion.
The table counter displays the number of rows unloaded. Select the required number of rows, in
any way possible, and apply the "Delete Selected Records" button.

Unloaded material

After applying the “Delete Selected Records” button, a window confirming this operation is
displayed.

The result of data deletion is shown in the figure. The row was successfully deleted from the
database, and the counter indicates one unit less.

The result of data deletion
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DELETING DATA IN THE “INPUT DATA” PANEL
It is a function for datasets that contain non-unloadable projections, allowing you to delete
material without unloading it to the “Unloading” panel.

In order to delete the lines loaded earlier, you need to open the input file, select the input rows
and select the "Mark as “Delete”" item in the drop-down menu (right mouse button).

Otherwise use the button on the toolbar.

Data deleting function

After that, the rows will be marked with the - “Delete” status icon and when the loader
starts, it will perform the deletion operation for these rows.

Rows prepared for deletion
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After the operation is completed, a message is displayed with a detailed description of the result

of data loading. In case of successful deletion the row is marked with the icon, or with the

icon if an error occurred while deleting. Errors, as in other cases, can be viewed by
double-clicking on the desired row.

A message with a result of data loading

The result of data deletion
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